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‘Jaws PDF Enterprise Suite .0

Global Graphics® is pleased to announce the release of Jaws PDF Enterprise Suite
[.0™. Jaws PDF Enterprise Suite provides high quality server-based and end-user-
based PDF creation, manipulation, annotation, merge and forms functionally in one
convenient software package. With Jaws PDF Enterprise Suite you get the highly
acclaimed Jaws PDF Server®, Jaws PDF Creator® and Jaws PDF Editor® software
in one convenient package. The Enterprise Suite also contains standalone versions of
Jaws PDF Editor and Jaws PDF Creator to ensure that administrators have maximum
flexibility in product depolyment options.

The Jaws PDF Enterprise Suite is shipped in an ISO archive which contains all the
single installer packages for the different Jaws PDF products. This includes

* Jaws PDF Server 4.0 (EN)

* Jaws PDF Server Macros (EN, DE, FR, ES, IT)
* Jaws PDF Desktop Suite 1.0 (EN, DE, FR)

* Jaws PDF Desktop Suite 1.0 Eval (EN, DE, FR)
* Jaws PDF Creator 4.1 (EN, DE, FR ES, IT)

* Jaws PDF Editor 3.5 (EN, DE, FR)

Jaws PDF Server and Jaws PDF Creator run in eval mode when you install without a
license key and will add a watermark. Jaws PDF Editor will run in eval mode 14 days
without limitations.

Visit www.jawspdf.com for the latest information on Jaws PDF Enterprise Suite.
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Supported platforms

Windows 2000 Professional (SP4)

Windows 2000 Server (SP4)

Windows XP Home/Professional (SP2)

Windows 2003 Server (SP1I)

Citrix® Presentation Server 3.0 on Windows 2003 Server SP|

Windows Server 2003 Terminal Services

Microsoft Office support

The Microsoft Office macros supplied with Jaws PDF Creator and Jaws PDF Server
Macros are supported in the following versions of Office:

Microsoft Office 2000 SP3
Windows 2000 Pro/Server SP4
Windows XP Home/Pro SP2

Microsoft Office XP SP3
Windows 2000 Pro/Server SP4
Windows XP Home/Pro SP2

Microsoft Office 2003 SPI Windows 2000 Pro/Server SP4
Windows XP Home/Pro SP2
Windows 2003 Server
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NOTE:

Windows 2003 Server running Windows Terminal Services

Citrix® Presentation Server 3.0 on Windows 2003 Server

The Jaws PDF Creator and Jaws PDF Server macros do not currently support Microsoft Office
2007.

Installation

)
2)

3)

)

3)

For installation the single files provided within the ISO Image need to be unpacked
to a suitable location on the harddisk. Applications for reading the ISO Image are for
example MagiclSO (www.magiciso.com), ISO Buster (www.isobuster.com), Virtual
CD (www.virtualcd.com), WinRar (www.winrar.com), Virtual Drive 10
(www.farstone.com) or Paragon CD-Rom Emulator (www.cdrom-emulator.com).

After this process the different products of the Jaws PDF Enterprise Suite can be
installed in seperate steps.

Upgrading Jaws PDF Server

If you are upgrading from a previous version of Jaws PDF Server, it is necessary to
remove the old version first. However, before you do this, export your existing
workflows so they can be used in the latest version of Jaws PDF Server.

Start the current version of Jaws PDF Server that is installed on your system.

In turn, for each of the workflows that you want to export, open a workflow and
choose File > Export. Enter a name for the file and then click Save. This saves the
workflow, and all the module settings, in a MWF export file (*.MEF). Repeat this for
each workflow that you want to preserve, and then close Jaws PDF Server.

You can now remove Jaws PDF Server from your system: in your system Control
Panel, open Add or Remove Programs and remove Jaws PDF Server.

Restart Windows to reset your system and to remove the Jaws PDF Server printers
from your system.

Install Jaws PDF Server 4.0 - see “Server-Side Installation Jaws PDF Server”.
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6) Start Jaws PDF Server and, in turn, import each configuration file with File > Import.
Save the workflow(s) with File > Save. Once the workflows have been saved they
can be opened in Jaws PDF Server 4.0 as normal, with File > Open.

Server-Side Installation Jaws PDF Server

The instructions in this section are for server-side installation of Jaws PDF Server 4.0.
Client-side installation instructions for Windows and Macintosh can be found further
down in "Client-side installation".

I) Double-click Jaws PDF Server 4.0.exe.

2) Follow the instructions as they appear in the InstallShield wizard, which will guide you
through the installation procedure.

3) Inthe wizard, select which Jaws PDF Server applications you want to install from the
following:

* Jaws PDF Server Program Files. Must be installed for Jaws PDF Server to work.
This item is selected by default.

*  Sample Files. Sample configuration workflows. Item is not selected by default.

* Jaws PDF Server as Windows Service. See the section: "Running Jaws PDF Server
as a Windows service" in the main Jaws PDF Server user manual for details. This
item is not selected by default.

* Jaws PDF Server Documentation. This item is selected by default.

4) When asked during the installation if you wish to remove module security, choose
Yes if you intend to share job processing across more than one installation of Jaws
PDF Server, otherwise choose No.

5) When the installer has finished copying the application files across, click Finish to close
the wizard.

6) To enable Mac OS 9 clients to connect to the Jaws PDF Server, install Print Services
for Macintosh|, available from Add/Remove Windows Components in your
system's Add or Remove Programs control panel.
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/)

NOTE:

)
2)
3)
4)

5)

6)

You must now restart Windows to register the Jaws PDF Server components with
the operating system.

It is strongly recommended to install the Patch 4.0.2 after having installed Jaws PDF Server 4.0.
The executable is located in the Jaws PDF Server folder also containing the specific release
notes.

Client-Side Installation Jaws PDF Server

The instructions in this section describe the client-side installation of Jaws PDF Server
4.0. Serversside installation instructions can be found in "Server-side installation"
above.

To install the Jaws PDF Server printer on Windows:

Open the system Control Panel and open Printers and Faxes.

Double-click Add Printer to run the Add Printer Wizard.

In the wizard, select the option to add a new network printer and click Next.

If you know the name and network path to the Jaws PDF Server printer you are
adding, enter it in the Name box. Otherwise, choose Browse for a printer; click Next
and select the printer from the list of network printers that are available.

The wizard will now install the Jaws PDF Server printer, installing the correct drivers
on your system in the process. When asked by the wizard if you wish to make it the
default printer, choose No.

To complete the printer installation, click Finish in the wizard. You will now be able
to use this printer to print documents to Jaws PDF Server.

Installing Jaws PDF Server Macros

The Jaws PDF Server Macros are supplied as a separate installation package to the
main Jaws PDF Server product installer.

Using Explorer, navigate to the location of the installer executable file and double-
click the program JawsPDFServerMacros.exe. Ihe Jaws PDF Server Macros
InstallShield Wizard will appear. To complete the installation follow the instructions
displayed on the screen.
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D
2)

3)

4)

3)

6)

Choose Settings > Control Panel from the Start menu. Select Add/Remove
Programs in the Control Panel window, and click Install... in the dialog box which
appears.

Run JawsPDFServerMacros.exe and press the Finish button.

Silent Installation Jaws PDF Server Macros

Navigate to the Jaws PDF Server Macro installation file.

In a command prompt box, enter the command:
<getupfile.exe> -r

Follow the instructions in the InstallShield wizard as normal to install Jaws PDF
Creator and create a response file called setup.iss in your Windows folder

If necessary you can open the response file in a text editor and edit it to suit your
environment. For example, you may wish to change the user name parameter
Name to use the system variable %REGISTEREDOWNER?%. like this:

Name=%REGISTEREDOWNER%
or
Name=%USERNAME%

Create a "oemsetup.ini" file and copy it in the folder where the setup file is.
After editing the response file, copy it to the setupfile folder. You can now use the
installer and the response file to silently install the Server Macros, as follows:

On the machine you want to silently install the Server Macros, log on as
Administrator and enter this command to run the installation: < Jaws PDF Editor
folder>\<Setupfile.exe> -s -fl"Drive:\Folder\setup.iss"

Note: if you want to create an Installshield error logfile, use the swich "-£2" instead
of "-£1" (note that after the switch "-£1" or "- £2", the quotation marks containing
the path and the .iss file, follow without a spacel).
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2)

3)
NOTE:

)
2)

3)

4)

Installing Jaws PDF Desktop Suite

The Jaws PDF Desktop Suite is available in three languages (EN, DE and FR) as full
and eval version. All of them are included in seperate single installers. The full version
of the Jaws PDF Desktop Suite has no limitations. The eval version always adds a
watermark to the created PDF and enables PDF Editor to be used for 14 days.

During the installation process, Antivirus, Firewall and Spyware applications should
be deactivated. Such programs may change settings and influence file operations
performed by the installer; which can lead to unpredictable behaviour.

You must be logged in as an Administrator to install Jaws PDF Desktop Suite.

Double-click Jaws PDF Desktop Suite 1.0.exeor Jaws PDF Desktop
Suite Eval 1.0.exe to startthe installation wizard, which will guide you
through the installation process.

When prompted, click finish to close the wizard and complete the installation.

In order to reinstall the Jaws PDF Desktop Suite, you must first uninstall the existing version.
To use Jaws PDF Desktop Suite under Windows Terminal Services a reboot of the Windows
2003 Server is necessary before installation.

Silent Installation Jaws PDF Desktop Suite

Navigate to the Jaws PDF Desktop Suite 1.0 installation file.

In a command prompt box, enter the command:
<getupfile.exe> -r

Follow the instructions in the InstallShield wizard as normal to install and create a
response file called setup.iss in your Windows folder.

If necessary you can open the response file in a text editor and edit it to suit your
environment. For example, you may wish to change the user name parameter
Name to use the system variable %REGISTEREDOWNER%. like this:
Name=%REGISTEREDOWNER%

or

Name=%USERNAME%
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5)

6)

NOTE:

Create a "oemsetup.ini" file and copy it in the folder where the setup file is.
The cemsetup. ini file contains (just copy + paste):

[Install]

SimpleInstall=N

SilentInstall=Y

Err Msg=Installation failed.

[InstFolder]

Path=C:\Programs\Global Graphics\PDF Suite
[UserInfol

Owner=MY_NAME

Organization=MY_ COMPANY

Remember to use a multi-user license number in your response file and to set an
installation folder which can be used on all user machines.

After editing the response file, copy it to the PDF Suite folder. You can now use the
installer and the response file to silently install Jaws PDF Desktop Suite as follows.

On the machine you want to silently install Jaws PDF Desktop Suite, log on as
Administrator and enter this command to run the installation:

<Setupfile.exe> -s -fl"Drive:\Folder\setup.iss"

If you want to create an Installshield error logfile, use the swich "-f2" instead of "-fI" (note that
after the switch "-fI" or "-f2", the quotation marks containing the path and the .iss file, follow
without a spacel).

Installation Jaws PDF Creator

On Windows you may upgrade to the latest version of Jaws PDF Creator without
uninstalling previous versions first. All your settings and PDF configuration profiles will
be retained for use in the new version.

During the installation and uninstallation process, Antivirus-, Firewall- and Spyware
applications should be deactivated. Such programs may automatically change settings
and influence file operations done by the installer; which can lead to unpredictable
behaviour and malfunctions within the Jaws applications.

Using Explorer, navigate to the location of the installer executable file and doubleclic
the JawsPDFCreator<language>.exe file, where <language> ist the
language version, such as EN for English.
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* Choose Settings > Control Panel from the Start menu. Select Add/Remove
Programs in the Control Panel window, and click Install... in the dialog box which
appears.

Navigate to the location of the installer executable file and doubleclick the
JawsPDFCreator<language>.exe file, where <language> ist the
language version, such as EN for English.

* The Jaws PDF Creator Install Shield Wizard will appear. To complete the installation
follow the insctructions desplayed on the screen.

NOTE:  You must be logged in as an Administrator to install Jaws PDF Creator.

During installation, you can either enter a serial number or run in evaluation mode,
as described in “Serial number” below.

Silent Installation
7) Navigate to the Jaws PDF Creator 4.1 installation file.

8) In a command prompt box, enter the command:
<getupfile.exe> -r

9) Follow the instructions in the InstallShield wizard as normal to install Jaws PDF
Creator and create a response file called setup.iss in your Windows folder.

|0) If necessary you can open the response file in a text editor and edit it to suit your
environment. For example, you may wish to change the user name parameter
Name to use the system variable $REGISTEREDOWNER%. like this:

Name=%REGISTEREDOWNER%
or
Name=%USERNAMES%

| 1) Create a "oemsetup.ini” file and copy it in the folder where the setup file is.
The oemsetup.ini file contains (just copy + paste):

[Install]

SimpleInstall=N
SilentInstall=Y

Err Msg=Installation failed.
[InstFolder]
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Path=C:\Programs\Global Graphics\Jaws PDF Creator
[UserInfo]

Owner=MY_NAME

Organization=MY_COMPANY

Remember to use a multi-user license number in your response file and to set an
installation folder which can be used on all user machines.

After editing the response file, copy it to the Jaws PDF Creator folder. You can now
use the installer and the response file to silently install Jaws PDF Creator as follows.

|2) On the machine you want to silently install Jaws PDF Creator, log on as Administrator
and enter this command to run the installation:

<PDF Creator folder>\<Setupfile.exe> -s
-f1"Drive:\Folder\setup.iss"

Note: if you want to create an Installshield error logfile, use the swich "- £2" instead
of "-£1" (notethat after the switch"-£1" or"- £2", the quotation marks containing
the path and the .iss file, follow without a spacel)

Upgrading

If you are upgrading Jaws PDF Creator, please note the following information.

Upgrading from v4.0: A new serial number is not required.

Upgrading from versions v3.61 and prior: You can upgrade from versions v3.61
and prior, but you must use a new serial number: If you wish to upgrade from earlier
versions such as v2.1 |, it is recommended to uninstall v2.x before installing the latest
version of Jaws PDF Creator.

Upgrade from evaluation to a fully working version: When you have evaluated
Jaws PDF Creator you may wish to upgrade to a fully working version. To do this, go
to the Settings tab of the Configure Jaws PDF Creator Control Panel and click the
About Jaws PDF Creator button.

The About dialog will appear: If you do not have a valid serial number, select the link
to the Jaws web site (www.jawspdf.com) and go to the How to buy page and follow
the instructions.

JAWS PDF ENTERPRISE SUITE 1.0 < 11>



JAWS PDF ENTERPRISE SUITE 1.0 - RELEASE NOTES
JAWS PDF ENTERPRISE SUITE 1.0 <« 12 )

When you have your serial number you can upgrade your version of Jaws PDF
Creator. To do this, click the Enter Serial Number option in the About Jaws PFDF
Creator dialog box. The Serial number dialog box will appear.

Enter your name, company and serial number and select OK. The user name must
consist of at least two characters. The company name is optional.

When you enter a valid serial number, your version of Jaws PDF Creator will become
licensed and fully functional.

Serial number

If you have a serial number for your version of Jaws PDF Creator you can use it at
installation time. This will immediately give you a licensed and fully featured version
of the application.

If however you wish to evaluate the product, you can install it without a serial number.
To do this, ensure that the word EVALUATION is entered in place of the serial
number (this occurs by default).

This will provide you with a working copy of the application. In this case, all PDF files
generated by the application will contain a watermark on every page.

Uninstallation

To remove Jaws PDF Creator from a Windows computer:
|) Select Settings > Control Panel from the Start menu.

2) In the Control Panel click Add/Remove Programs and select Jaws PDF Creator in
the list.

3) Click the Add/Remove button to remove the program.

A confirmation prompt is displayed.
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In some circumstances the uninstaller is unable to remove the Jaws PDF Creator
printer from the Windows printing system. If this happens a message is displayed
asking you to wait a few minutes and re-attempt the uninstall. If the second attempt
also fails, you should reboot your computer and uninstall again.

NOTE:  An uninstall of Jaws PDF Creator removes the application and the registry entries for any
configurations created by that particular Administrative user, but does not remove any of the
configurations created by any other users who have logged onto that machine. Because these
user configurations are left behind on the machine, individual users can then reinstall Creator
retaining the configurations that they previously created.

If so desired, the configurations for a user can be removed manually by logging in as
that user and removing the registry key:

HKEY_CURRENT_USER\Software\Global Graphics\Jaws PDF Creator

See the documentation for your operating system for details on how to edit registry
settings.

NOTE:  If you still have the Word menu item for Jaws PDF Creator after uninstalling, the macro itself
has been deleted but the reference in Word could not be uninstalled. This can be manually
removed as follows:

1) In Word, Select "Tools > Customize' (Or right-click the Jaws PDF Creator icon and
select 'Customize").

2) lIgnore the 'Customize' window itself and select the Word 'File' menu
3) Right-click the menu item you wish to delete (Jaws PDF Creator)

Select 'delete’ from the drop-down.

Installation Jaws PDF Editor

Follow the procedure described below to install Jaws PDF Editor using the
InstallShield wizard.

To install Jaws PDF Editor:
I) Navigate to the Jaws PDF Editor installation file: JawsPDFEditor3.5.exe

2) Double-click the installation program to start the InstallShield wizard.
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3)
)

Follow the instructions in the wizard as they appear.

Click Finish to close the wizard and complete the installation procedure.

NOTE:  Jaws PDF Editor installation need admin user account.

)
2)

3)

4)

3)

Silent Installation

Navigate to the Jaws PDF Editor 3.5 installation file.

In'a command prompt box, enter the command:
<getupfile.exe> -r

Follow the instructions in the InstallShield wizard as normal to install Jaws PDF Editor
and create a response file called setup.iss in your Windows folder.

If necessary you can open the response file in a text editor and edit it to suit your
environment. For example, you may wish to change the user name parameter

Name to use the system variable %REGISTEREDOWNER%. like
this:

Name=%REGISTEREDOWNER%

or

Name=%USERNAME%

Remember to use a multi-user license number in your response file and to set
aninstallation folder which can be used on all user machines. After editing the
response file, copy it to the Jaws PDF Editor 3.5 folder. You can now use the installer
and the response file to silently install Jaws PDF Editor, as follows.

On the machine you want to silently install Jaws PDF Editor, log on as Administrator

and enter this command to run the installation:

<Jaws PDF Editor folder>\<Setupfile.exe> -s
-fl1"Drive:\Folder\setup.iss"
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Uninstall

)
2)

3)

)
2)

3)

Note: if you want to create an Installshield error logfile, use the swich "-f2" instead of "-f1". (note
that after the switch "-fI" or "-f2", the quotation marks containing the path and the .iss file,
follow without a spacel)

Upgrading Jaws PDF Editor

Upgrading from Jaws PDF Editor 2.x versions - the previous versions are
uninstalled during the new 3.5 installation process, but all settings and customizations
are migrated to the new version.

Upgrading from Jaws PDF Editor 3.0 - no need to uninstall this version before
installing Jaws PDF Editor 3.5. It is an update process without the need to enter a
license key and all settings or customizations will be migrated to the new version.

Uninstallation Jaws PDF Server Macros

To remove Jaws PDF Server Macros:
Select Settings > Control Panel from the Start menu.

In the Control Panel click Add/Remove Programs and select Jaws PDF Server Macros
in the list.

Click the Add/Remove button to remove the program. A confirmation prompt is
displayed.

Uninstallation Jaws PDF Desktop Suite
To remove Jaws PDF Desktop Suite:

Select Settings > Control Panel from the Start menu.

In the Control Panel click Add/Remove Programs and select Jaws PDF Desktop Suite
in the list.

Click the Add/Remove button to remove the program.
A confirmation prompt is displayed.
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In some circumstances the uninstaller is unable to remove the Jaws PDF Creator
printer from the Windows printing system. If this happens a message is displayed
asking you to wait a few minutes and re-attempt the uninstall. If the second attempt
also fails, you should reboot your computer and uninstall again.

NOTE:  An uninstall removes the application and the registry entries for any configurations created by
that particular Administrative user, but does not remove any of the configurations created by
any other users who have logged onto that machine. Because these user configurations are left
behind on the machine, individual users can then reinstall the Jaws PDF Desktop Suite retaining
the configurations that they previously created.

If so desired, the configurations for a user can be removed manually by logging in as
that user and removing the registry key:

HKEY_CURRENT_USER\Software\Global Graphics\Jaws PDF Creator

See the documentation for your operating system for details on how to edit registry
settings.

Uninstallation of Jaws PDF Creator

To remove Jaws PDF Creator from a Windows computer:
I) Select Settings > Control Panel from the Start menu.

2) In the Control Panel click Add/Remove Programs and select Jaws PDF Creator in
the list.

3) Click the Add/Remove button to remove the program.
A confirmation prompt is displayed.

In some circumstances the uninstaller is unable to remove the Jaws PDF Creator
printer from the Windows printing system. If this happens a message is displayed
asking you to wait a few minutes and re-attempt the uninstall. If the second attempt
also fails, you should reboot your computer and uninstall again.

NOTE:  An uninstall of Jaws PDF Creator removes the application and the registry entries for any
configurations created by that particular Administrative user, but does not remove any of the
configurations created by any other users who have logged onto that machine. Because these
user configurations are left behind on the machine, individual users can then reinstall Creator
retaining the configurations that they previously created.
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NOTE:

2)
3)

D
2)
3)
)
5)
6)

If so desired, the configurations for a user can be removed manually by logging in as
that user and removing the registry key:

HKEY_CURRENT_USER\Software\Global Graphics\Jaws PDF Creator

See the documentation for your operating system for details on how to edit registry
settings.

If you still have the Word menu item for Jaws PDF Creator after uninstalling, the macro itself
has been deleted but the reference in Word could not be uninstalled. This can be manually
removed as follows:

In Word, Select "Tools > Customize' (Or right-click the Jaws PDF Creator icon and
select 'Customize").

lgnore the 'Customize’ window itself and select the Word 'File' menu
Right-click the menu item you wish to delete (Jaws PDF Creator)

Select 'delete’ from the drop-down.

Uninstallation of Jaws PDF Editor

To uninstall Jaws PDF Editor from your computer, do the following:

Click Start > Settings > Control Panel, to open the Windows Control Panel.
Double-click Add/Remove Programs to open the Add/Remove Programs dialog.
Click the Change or Remove Programs button.

From the list of programs, choose Jaws PDF Editor 3.5.

Click Remove, and then close the Add/Remove Programs dialog when Jaws PDF
Editor has been removed.

To complete the removal procedure, check that the folder below is removed. If it is
not, manually delete the folder:
C:\Program Files\Global Graphics\Jaws PDF Editor
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List of resolved issues

Jaws PDF Creator resolved issues

Issue # Description

162272 Links created to PDF files where the file being linked to contains a space in the
file name, no longer cause an error.

162526 The Microsoft Excel, Word or PowerPoint Macros no longer change the value

161946 of the default printer to Jaws PDF Creator:

162869 When launching Excel, Word or PowerPoint, the contents of the clipboard are
no longer replaced with the Jaws PDF Creator icon graphic.

163034 The Microsoft Office toolbars for Jaws PDF Creator now remember where they
have been moved to and are predictably placed when Microsoft Office is
restarted.

163897 Setting the Microsoft Excel macro to 'Create one PDF file for the entire [Excel]

document' and 'Create PDF file from all worksheets' now correctly sets the
sheet-level bookmarks.

Jaws PDF Editor resolved issues

Issue # Description

162272 Links created to PDF files where the file being linked to contains a space in the
file name, no longer cause an error.

162526 The Microsoft Excel, Word or PowerPoint Macros no longer change the value

161946 of the default printer to Jaws PDF Creator:

162869 When launching Excel, Word or PowerPoint, the contents of the clipboard are
no longer replaced with the Jaws PDF Creator icon graphic.

163034 The Microsoft Office toolbars for Jaws PDF Creator now remember where they
have been moved to and are predictably placed when Microsoft Office is
restarted.

163897 Setting the Microsoft Excel macro to 'Create one PDF file for the entire [Excel]

document' and 'Create PDF file from all worksheets' now correctly sets the
sheet-level bookmarks.
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Issue # Description
162855 Jaws PDF Editor now keeps a change to the rendering engine selection. After
the application has been closed and reopened, the selection reverts back to the
default setting.
163026 Using the scrollbars, it is now possible to correctly navigate a document that is

zoomed above 200% magnification.

163056 The 'Delete All Comments' command - available by right-clicking the
Comments tab - can be selected now. Comments can easily be deleted by
selecting them individually and choosing 'Delete Comment'.

163145 The selected item in a forms listbox that has a vertical scroll-bar no longer revert
to the top-most item when the selection is confirmed.

163154 Comment annotations that are positioned outside of the document display area
are now forced to display within the document boundary.

163172 Documents that contain large numbers of form fields are rendered to the
screen much faster.

163379 The German / French user manuals are now correctly opened from the
appropriate menu items / shortcuts.

163406 It is now no longer possible to print 'secured' pages in a document to an
unsecured file, thereby bypassing PDF security.

163407 The Fast Web View status of a document is now correctly displayed in the
Document Properties display.

163497 The mouse cursor is now correctly reset after clicking on an item in a forms
listbox.

163500 When tabbing to a listbox, it is now possible to use the keyboard arrow up /
down buttons.

163500 When navigating a list box in a PDF form, it is now possible to use the keyboard
arrow keys to move up and down the list.

163501 Tabbing between forms is now possible in all zoom and view modes.

163518 Text searching in the 'up' direction now starts from where the mouse cursor is

positioned in the document.

163520 When installing Jaws PDF Editor in silent mode, the license key is no longer
incorrectly installed to HKEY_current_user in the Windows registry, but is be
installed to HKEY_LOCAL_MACHINE and pushed to all PCs while
implementing the MS file.
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163536 Having selected an item in a forms listbox, it is now possible to tab to the next

form field without having to click on the document first

163539 Tabbing between form fields when a PDF document is shown in a browser now
works correctly.

163541 When selecting items in a PDF form listbox, now you only have to click an item
once in order to select it. Selecting with Shift+Click or Control+Click now also
works correctly.

163614 Highlight comments now print correctly.

n/a General enhancements to the screen rendering engine.

List of known issues

Jaws PDF Server known issues

Issue # Description

10403 Some memory issues with large files remain.

20088 When the File Type is set to ps in the Input module, eps files can be processed.
20089 The priority setting in the Input module is ineffective.

Jaws PDF Server Macros known issues

Issue # Description

162155 When using the Excel macro the hyperlink bounding box shifts further and
further away from linked text as more links are created.
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162157 When creating PDF files from the Excel macro, a link to another cell on the same

spreadsheet gives the wrong result. Instead of jumping to the correct target, it
jumps to a page that is actually on another worksheet in the original Excel file.

162159 Within the Excel macro the "Destination magnification” option on the
Bookmarks tab bases its sizing on the settings of the first page of the workbook,
and not on the actual destination of the bookmark.

162165 If a hyperlink spans more than one line in a PowerPoint slide, only the first line
will be linked to the PDF generated by PowerPoint macro.

162179 If the file name contains a comma before the extension, the PDF file cannot be
generated using Excel macro.

Jaws PDF Creator known issues

Issue # Description

161093 If Jaws PDF Courier is installed on your Windows system and you are upgrading
to Jaws PDF Creator 4.1 from an earlier version, any custom configurations you
have set up will be lost when you install Jaws PDF Creator 4.1. To save your
custom configurations we recommended that you export them (using the
Export Configurations utility in Jaws PDF Creator 4.1) before installing.

161256 On a Windows system, having a configuration with the same name as one which
already exists will overwrite the existing one without warning.

161319 On a Windows system, syntax errors may occur in an XML exported Jaws PDF
Creator 4.1 configuration file. These errors could affect the configuration
settings when the XML file is subsequently importing into Jaws PDF Creator 4. 1.

161863 Custom configurations created by administrators are saved to a general location
and will be lost after uninstallation. If you want to save your configurations, you
should export them into an XML file before uninstalling. All configurations
created by restricted users are saved to a user-specific location and are retained
when uninstalling.

161973 When using the -PDFX_3_2002.jcp plugin all PostScript language files that
contain smooth shading fail with the following error: %% [ Error:
typecheck; OffendingCommand: --if--]1%% The files
distill correctly when using the -PDFX-la_2001.jcp
plugin.
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162025 The embedded PDF time stamp that is added by Jaws PDF Creator has been

found to be inaccurate for a number of time zones.

162038 When uninstalling Jaws PDF Creator 4.1 on a system running Windows XP
Professional with Jaws PDF Courier installed, the Add and Remove Programs
window remains opens cannot be closed in the usual manner. To close it, it is
necessary to quit rundli32.exe in the Task Manager

162155 When using the Excel macro the hyperlink bounding box shifts further and
further away from linked text as more links are created.

162157 When creating PDF files from the Excel macro, a link to another cell on the same
spreadsheet gives the wrong result. Instead of jumping to the correct target, it
jumps to a page that is actually on another worksheet in the original Excel file.

162159 Within the Excel macro the "Destination magnification" option on the
Bookmarks tab bases its sizing on the settings of the first page of the workbook,
and not on the actual destination of the bookmark.

162160 The Jaws PDF Creator Manual says for the Excel macro that the "Destination
magnification" option on the Bookmarks tab decides the zoom value when the
PDF file is opened. It should say that the "Destination magnification" option on
the Bookmarks tab decides the zoom value when a Bookmark is clicked.

162165 If a hyperlink spans more than one line in a PowerPoint slide, only the first line
will be linked to the PDF generated by PowerPoint macro.

162771 On a Windows system, to prevent a system crash when you logon to Citrix
Server, you must remove the following registry keys after uninstalling Jaws PDF
Creator 4.1:

HKEY_ LOCAL MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Winlogon

Value Name: AppSetup

Value Data: CtxHide.exe

UsrLogon.Cmd, cmstart.exe, "C: \ProgramFiles\JawsSystems\
Jaws PDF Creator\PDFClient.exe"

Value Name: UserInit:

Value Data: c:\WINDOWS\system32\userinit.exe,
"C:\ProgramFiles\JawsSystems\Jaws PDF
Creator\PDFClient.exe",

162914 The encryption level message that is displayed in the Security dialog when using
[28-bit security, should read "128-bit (PDF |.4 or later)".
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n/a TrueType fonts with bold or italic styles applied to them may not be searchable

on systems where the font style is missing from the TrueType font set.

n/a Jaws PDF Creator supports CID fonts (Type O and 2), whether they are
embedded or not. However, we recommend that you always embed CID fonts
to ensure page fidelity when the PDF is viewed on other systems.

n/a The performance of Jaws PDF Creator 4.1 may be affected when distilling a
PostScript language file that has 'preserve OPI comments' enabled if the file
contains a high resolution image, rather than a low resolution proxy.

Jaws PDF Editor known issues

Issue # Description

161304 Annotation comments in a printed document are printed in the location they
appear in the PDF page, and may therefore obscure the text they are
commenting on. Currently there is no facility in PDF Editor for choosing where
you want comments to be printed.

161726 The recently used file list is not cleared from the File menu after removing and
re-installing the application.

162156 Bounding boxes around hyperlinks are currently unsupported.

162241 The password entry dialog box incorrectly opens when attempting to display a
password protected PDF in full screen mode.

162246 Deleting pages from a document by selecting the page thumbnail and pressing
Delete is currently unsupported.

162255 The "Previous view" and "Next view" buttons do not currently support moving
between PDF documents.

162346 There is an intermittent issue affecting the printing of multiple collated copies of
a PDF document from Jaws PDF Editor that results in only one copy of the
document being printed.

162593 The displayed error message text that appears when attempting to save a read-
only file is not word-wrapped, but instead appears on one line in a long dialog
box.
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162659 PDF Editor does not currently support the ability to add external hyperlinks

either between PDF files, URLs, or e-mail addresses. It also does not allow
existing hyperlinks to be edited.

162769 Using a page thumbnail to insert a page into a PDF document may cause Jaws
PDF Editor to quit unexpectedly.

162878 When printing an unsaved PDF document that has open annotation popup
boxes or form fields, Jaws PDF Editor renames the document to a temporary
file. Although the file has been renamed, it does not appear in the 'most recently
used' list (under the File menu). If the document has not been saved prior to
printing, changes to annotations will be lost in the original file.

162932 Jaws PDF Editor does not currently provide an option that allows form-fields to
be visible when annotations are hidden.

163007 Roman characters do not appear in vertical text on Japanese and other non-
Western systems when using a substitute font to replace missing fonts. This is
because the standard MS-Mincho and MS-Gothic substitute fonts do not contain
rotated Western glyphs.

163057 When several annotations have been selected in a PDF file the 'Export
command' option does not appear in the right-click context menu.

163143 When using a combo-box in a PDF form, the first time an item is selected the
item moves to the top of the list.

163268 Jaws PDF Editor does not warn you if you enter an invalid page range when
extracting pages from a file.

163554 PDF form subsets, known as child-fields, are not currently supported by Jaws
PDF Editor. This means, for example, that calculations will not work when
entered into child-fields.

163834 Comboboxes do not drop down their menu when clicked on the downarrow
button.

162018, The following form actions are not currently supported by Jaws PDF Editor:

163211, appending a page, save/save as file.

163728

162992, Jaws PDF Editor does not currently support form-field data formatting and

162926 validation.

163017, Jaws PDF Editor does not currently support special number formatting in form-

163005 fields, such as negative values in parenthesis, or negative numbers in red.
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Issue # Description

163210, Jaws PDF Editor does not currently support text searching of PDF form data.

162044

n/a Displaying annotations and form fields in thumbnail view is currently
unsupported.

n/a Some unpredictable behaviour can occur during the applications launch when
Jaws PDF Editor is reinstalled as eval version into a new path.

n/a When you select a value in a listbox and close Jaws PDF Editor without any
other action, the selection does not get saved. It is necessary to click somewhere
else in the document to activate the change.

n/a Listboxes do not support confirmation of a newly selected value by pressing the
Return key.

n/a If the file association for PDF files has been set to Jaws PDF Editor, it does not
get re-set during the deinstallation. The "Jaws" icons may remain for PDF files
until a new association is defined.

n/a The original values remain when a selection in a multi-selection listbox is made
with only one click. It is necessary to click twice to remove the other selections.
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Part number: Jaws PDF Enterprise Suite 1.0

Copyright © 19922006 GLOBAL GRAPHICS SOFTWARE LIMITED

All Rights Reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Global Graphics Soft-
ware Limited.

The information in this publication is provided for information only and is subject to change without notice. Global Graphics Software
Limited and its affiliates assume no responsibility or liability for any loss or damage that may arise from the use of any information in
this publication. The software described in this book is furnished under License and may only be used or copied in accordance with
the terms of that License.

Jaws, the Jaws logo, Jaws PDF Creator, Jaws PDF Editor, Jaws PDF Server and Jaws PDF Courier are trademarks of Global Graphics
Software Limited, which may be registered in certain jurisdictions. Global Graphics is a trademark of Global Graphics S.A., which may
be registered in certain jurisdictions.

Adobe, Adobe Photoshop, Adobe Type Manager, InDesign, Acrobat, Display PostScript and PostScript are registered trademarks and
Distiller and PostScript 3 are trademarks of Adobe Systems Incorporated.

Fonts copyright © 2000-2004 Timo Lehtinen. All Rights Reserved.
http://www.timolehtinen.com/type/.

Other brand or product names are the registered trademarks or trademarks of their respective holders.

Licensed under U.S Patent No. 4,558,302 and foreign counterparts.

END USER LICENCE

This License (and the terms and conditions contained within it) is a legal agreement between you (the End User) and Global Graphics
Software Incorporated, with a principal address at 5875 Trinity Parkway, Suite |10, Centreville, VA 20120 ("Global Graphics"). This
License sets out the terms upon which Global Graphics and its licensors licenses to the End User the Software. The End User must
only install and use the Software in accordance with the terms of this License and the End Users' particular attention is drawn to the
terms of the license (Clause 2) (and the restrictions and prohibitions contained within that Clause), the limited warranty (Clause 3)
and the limitation of liability (Clause 4).

By installing, loading, copying, storing or otherwise using the Software, the End User agrees to be bound by the terms of this License.

If the End User does not wish to be bound by the terms of this License, the End User should not install, load, copy, store or otherwise
use the Software, and return the Software or the Documentation for a refund of the Total Charges.

| INTERPRETATION
[.I' The expressions set out below shall have the meanings in this License ascribed to below:

.2 Charges mean the fee payable by each End User in accordance with Global Graphics' then current price list and Total
Charges means the total fees payable by all End Users;

[.3 End Users means the individual or company licensed to use the Software under or in respect of this License as set out in the
Purchase Order;

I.4  Intellectual Property means copyright, domain names, design rights, database rights, semi-conductor topographical rights, pat-
ents, trade marks (registered or unregistered), service marks, registered designs or any applications thereof, and all other intel-
lectual or industrial property rights of a similar nature and Intellectual Property Rights means rights in such intellectual
property;

[.5  Purchase Order means the written or electronic order for the Software submitted by the End User;
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[.6  Software means the registered version of the Software contained on the disks (CD-ROM(s) or other media) with which this
License is provided, together with any changes, modifications, adaptations or alterations thereto together with any subsequent
versions, releases and corrections and any accompanying documentation.

2 LICENCE

2.1 In consideration of the payment by the End User of the Total Charges, Global Graphics grants to the End User; a non exclu-
sive, non transferable right to install and use the Software on the terms of this License. For the avoidance of doubt, the End
User is responsible for the installation of the Software and installation must be performed in accordance with the terms of the
documentation accompanying the Software.

2.2 The End Users' rights and obligations in respect to the use of the Software are as follows:

2.2.1 For asingle user license, the End User may install and use the number of copies indicated on the inside cover of this
booklet, provided always that only one copy of the Software is used on a single computer subject to both the following
conditions being satisfied;

2.2.2 (a) End User interaction is required to operate the Software;
2.2.3 (b) there is a one-to-one (I:1) relationship between the End User and the Software.

224 For a server-based license, the End User may install one copy of the Software on a single file server for use on a local
or wide area network, provided that the End User must not exceed the total numbers of licensed copies, per server;
indicated on the inside cover of this booklet. For the avoidance of doubt, server-based Software may only be accessed
by users in the same company (or group of companies) as listed on the Purchase Order.

2.2.5 notwithstanding anything to the contrary, if the End User is using Windows Terminal Services, or Citrix Metaframe Pre-
sentation Server the End User must purchase a licensed copy of the Software (Jaws PDF Creator and/or Jaws PDF Edi-
tor) for each individual user who is capable of accessing and using the Software on a non-concurrent basis.

2.3 The End User may install an additional copy of the Software on a home or portable computer; provided that the End User is
the primary user of the computer on which the Software was first installed. However, the Software on the secondary com-
puter may not be used by another person at the same time that the Software on the primary computer is being used.

24 The End User may make one copy of the Software for archival purposes, provided the archive copy is not installed or used on
any computer.

iThe End User shall not (and shall procure that any third party shall not):

2.5 copy or make derivative works from the Software, except as set out above. Any copies that you are permitted to make pur-
suant to this License must contain the same copyright and other proprietary notices that appear on or in the Software.

2.6 sublicense, assign, rent, lease, lend, export or re-export or otherwise market or distribute the Software, or any portion
thereof.

2.7 modify, change, alter; adapt, translate, reverse engineer, decompile, disassemble or otherwise attempt to discover the source
code of the Software, or create derivative works from the Software, except that in the European Community, you may
reverse engineer only for interoperability purposes and then only if all conditions of Article 6 of Council Directive
91/250/EEC are met.

2.8 [make the Software accessible from the Internet, or other public network, or over a privately operated computer network
outside of the company listed on the Purchase Order]

3 WARRANTY

3.1 Global Graphics warrants to the End User that the Software will perform substantially in accordance with the documentation
supplied with the Software for the ninety (90) day period following receipt by the End User of the Software. To make a war-
ranty claim, the End User must return the Software to the location where they obtained it together with a copy of proof of
purchase within such a ninety (90) day period.

3.2 Global Graphics do not and cannot warrant that the Software is free from minor errors not materially affecting the perfor-
mance or functionality of the Software.

3.3 Global Graphics do not and cannot warrant that the Software is and will be free from viruses (including, but not limited to,
hidden routines, worms, logic or time bombs, disabling or disruptive codes or routines, expiration dates and software
switches). However; whilst Global Graphics has used reasonable endeavors and taken all reasonable steps to check the same,
the End User is solely responsible for performing virus and other checks on the Software.

34  Global Graphics are not and shall not be liable for any failure or malfunction resulting wholly or to any material extent from
the negligence, operator error, any other misuse or abuse of the Software.
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35

36

37

38

Global Graphics are not and shall not be liable for any failure to comply with the terms of this License including but not lim-
ited to, the decompilation, transfer; disassembly, reverse engineering, modification, alteration or adaptation of the Software or
its merger with any other program or any maintenance repair adjustment alteration or enhancement of the Software by any
person other than Global Graphics.

Global Graphics are not and shall not be liable for any failure by the End User to implement recommendations advised by
Global Graphics in respect of, or solutions for faults in, the Software.

If the Software does not perform substantially in accordance with the documentation supplied with the Software, the entire
and exclusive liability and remedy shall be limited to either, at Global Graphics option.

3.7.1 the replacement of the Software; or
3.72 the refund of the Total Charges

THE REMEDIES SET FORTH IN THIS SECTION 3 ARE YOUR SOLE AND EXCLUSIVE REMEDIES AT LAW OR IN
EQUITY FOR BREACH OF WARRANTY. TO THE MAXIMUM EXTENT PERMITTED BY LAW, GLOBAL GRAPHICS DIS-
CLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

4  LIMITATION OF LIABILITY

4.1

IN'NO EVENT SHALL GLOBAL GRAPHICS' ORITS LICENSORS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDI-
RECT OR CONSEQUENTIAL DAMAGES EVEN IF GLOBAL GRAPHICS HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES IN ADVANCE. IN NO EVENT SHALL GLOBAL GRAPHICS' LIABILITY EXCEED THE AMOUNT OF
THE TOTAL CHARGES PAID BY THE END USER FOR USE OF THE SOFTWARE.

5 INTELLECTUAL PROPERTY, OWNERSHIP AND RISK

5.1

52

53

5.4

The Software is and remains the property of Global Graphics and/or its licensors and is protected by amongst other things
copyright law. All right, title to, ownership of and all Intellectual Property Rights and all other proprietary rights in the Soft-
ware belong to and shall belong to, vest in and shall remain vested in Global Graphics (and its licensors as the case may be).

In addition, and for the avoidance of doubt, the End User shall have no right to use Global Graphics' or its licensor's trade-
marks with its promotion or publication of the Software, without Global Graphics' written approval.

The End User shall not remove any product identification, copyright notices, trademarks or other legends set forth on the
Software and shall reproduce all such notices on any copies.

Risk in the Software passes to the End User on delivery.

6 CONFIDENTIALITY

6.1

6.2

The Software is owned by Global Graphics and its licensor(s) and is protected by copyright law, trade secret law, and as oth-
erwise set forth in this License.

The End User agrees not to disclose or make available the Software, or any portion or copy thereof, or the results of any
benchmark tests using the Software, to any third party without Global Graphics prior written consent.

7 TERMINATION

7.1 Global Graphics may terminate this License immediately as notice if you fail to comply with any of the terms and conditions of
this Agreement. Upon termination, the End User shall cease using the Software and shall remove the Software from any per-
sonal computer or server and destroy all copies of the Software. Termination of this Agreement shall be without prejudice to
the other rights and remedies of the either party.

7.2 The provisions of Clauses 4,5 and 6 shall survive the termination of this Agreement as shall any provisions which are
expressed, or by implication are intended, to survive termination of this Agreement.

8 GENERAL

8.1 This License shall be construed in accordance with the substantive laws of the Commonwealth of Massachusetts.

8.2 This License is personal to Global Graphics and the End User. Neither party shall assign, novate, sub-contract or otherwise
dispose of all or any part thereof without the previous consent in writing of the other party.

8.3 No variation of this License shall be binding upon the parties unless the same shall be in writing duly signed by a director on

its behalf and such variation shall be peculiar to the circumstances mentioned by such writing and shall not be regarded as a
general variation. The failure of either party to insist upon strict performance of any provision of this License, or the failure of
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either party to exercise any right or remedy to which it is entitled hereunder, shall not constitute a waiver thereof and shall
not cause a diminution of the obligations established by this License.

8.4  Except as otherwise expressly provided no License communication from one party to the other shall have any validity under
this License unless made in writing by or on behalf of either party. Any notice or other communication whatsoever which is
required or authorized by this License to give or make to the other; shall be served by e-mail, facsimile or post in a prepaid
first class letter; addressed to Global Graphics at the registered office set out in the preamble to this License. If any notice or
other communication is sent by e-mail, the sender shall confirm the communication by way of a letter sent by first class post.
Any letters sent by first class post which are not returned as being undelivered that notice or communication shall be deemed
for the purposes of this License to have been given or made on the second day after posting. Any notice served by facsimile
or telex shall be considered to have been delivered when actually received by the recipient.

8.5  This License together with the Schedule to it, represents the entire agreement between the parties and supersedes all prior
agreements, arrangements and understanding between the parties to that subject matter.

8.6  If any provision of this Agreement is held invalid, illegal or unenforceable for any reason by any court of competent jurisdic-
tion, such provision shall be severed and the remainder of the provisions hereof shall continue in full force and effect as if this
License had been executed with the invalid, illegal or unenforceable provision eliminated.

9 US. GOVERNMENT SUPPLY

9.1 This Software is a commercial computer software program developed at private expense and is subject to the following
Restricted Rights Legend: "Use, duplication, or disclosure by the United States Government is subject to restrictions as set
forth in (i) FAR 52.227-14 Alt lll, (if) FAR 52.227-19; as applicable". Use by agencies of the Department of Defense (DOD) is
subject to Global Graphics customary commercial license as contained in the accompanying license agreement, in accordance
with DFAR 227.7202-1 (a). For purposes of the FAR, the Software shall be deemed 'unpublished' and licensed with disclo-
sure prohibitions, rights reserved under the copyright laws of the United States.

10 CONTACT INFORMATION

[0.1 Help and assistance together with details of support and maintenance are available on the website, details of which are set
out in the documentation accompanying the Software. The End User should wherever possible seek help and assistance from
and contact Global Graphics via the website, however any written communications should be sent to the registered office,
details of which are set out in the preamble to this License. If sending mail, or leaving bug reports on the web server, please
remember to include at least your email address so that we can reply to you..

Europe: United States: Web:

. o . www.jawspdf.com
Global Graphics Software Limited Global Graphics Software, Inc.
Barrington Hall 5875 Trinity Parkway E-mail:
Barrington Suite 110 creator-support@jawspdf.com
Cambridge, CB2 5RG Centreville, VA 20120 editor-support@jawspdf.com
UK USA server-support@jawspdf.com
telephone +44 1223 873 800 telephone +1 703 266 9588
fax +44 1223 873 873 fax +1 703 266 9582
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